








Kurzanleitung für das REVOLECTRIX ® Cellpro 10s Ladegerät

Eine vollständige Beschreibung aller Schritte finden Sie in dieser Anleitung.

ACHTUNG: Diese Kurzanleitung ersetzt die vollständige Anleitung nicht. Bitte lesen Sie die  
vollständige Anleitung bevor Sie den Cellpro 10S in Betrieb nehmen.

DIESE ANLEITUNG ist nur gültig für Firmware 2.11 – 2.14 des Cellpro 10S Die Firmware  
Version Ihres Cellopro 10S wird Ihnen beim Einschalten des Cellpro 10S im Display angezeigt.

A.Schließen Sie das Ladegerät an eine Gleichstromquelle mit mindestens 10V bis maximal 16V 
Ausgangsspannung an.

B.Schließen Sie den/die Akku(s) an das Ladegerät an.
 Stecken Sie den/die  Balancerstecker in die beiden Buchsen der Ladekanäle 1 und 2 auf der rechten 

Seite des Ladegerätes (falls erforderlich, verwenden Sie einen geeigneten Balancer Adapter).
 Wenn Sie nur einen Akku laden, stecken Sie den Balanceranschluss den Akkus in CH1. Verbinden 

Sie die Anschlzsskabel des Akkus mit den beiden äußeren Buchsen oben auf dem Ladegerät.
 Beim Laden von zwei Akkus: Schließen Sie die Anschlusskabels des Akkus an CH1 in das 

Buchsenpaar #1 und die Anschlusskabel des mit CH2 verbundenen Akkus in das Buchsenpaar #2. 
 Wenn Sie nur über die Balancerkabelladen wollen, so stecken Sie den „Plug Blocker“ in die beiden 

äußeren Buchsen.
C.Ladegerät konfigurieren:

 Überprüfung des gewählten Presets:  Drücken Sie den Mode  Taster.
 Auswahl eines anderen Presets:  Drücken Sie den Mode  Taster solange, bis der Name und die 

Einstellungen des gewünschten Presets im LCD Display angezeigt werden.
 Einstellungen des ausgewählten Prests ändern:  Drücken Sie den Mode  Taster und halten Sie ihn 

gedrückt, um “Chemistry“ (Akkutyp) und/oder Ladestrom festzulegen.  Zum Verlassen drücken Sie 
den Mode  Taster und halten Sie ihn gedrückt.

D.Drücken Sie den Start/Stop  Taster für eine Sekunde, um den Ladevorgang zu starten.
E.Während des Ladens:

 Anzeige der Ladedaten:  Drücken Sie den Mode  Taster einmal pro Anzeige, um alle Werte 
anzuzeigen.

 Ladevorgang beenden: Drücken Sie den Start/Stop  Taster für eine Sekunde.
F. Wenn der/die Akkus geladen sind, beendet das Ladegerät automatisch den Ladevorgang  und 

signalisiert dies mit Pieptönen für etwa 30 Sekunden.
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Funktionen des Cellpro 10s Ladegerätes

Sie können im Automatik-Modus den Ladestrom des Cellpro 10s Charger auf einen von drei Werten —
1C, 2C oder 3C—entsprechend der Kapazität des/der zu ladenden Akkupacks einstellen.  Nach Auswahl 
eines dieser Werte bestimmt das Ladegerät selbsttätig die Kapazität des zu ladenden Akkus und stellt 
unter Verwendung der „FMA’s advanced Fuel Gauging” Technologie automatisch den richtigen 
Ladestrom ein. Sie können den Ladestrom jedoch auch manuell zwischen 0,1A und 20A in 0,1A-
Schritten einstellen. Weiterhin können Sie den „Storage Charge” Modus auswählen, wenn Sie den Akku 
über einen längeren Zeitraum  hinweg nicht verwenden. Hierbei wird der Akku für längere Lagerung 
nur bis auf 50% seiner Kapazität geladen. Das Ladegerät kann mehrere Akkutypen (z.B. Li-Po, Li-Io 
oder A123) und vordefinierte Ladeparameter unterstützen..
Wenn ein Akku an das Ladegerät angeschlossen ist, wird er anfänglich mit der ausgewählten Ladereate 
bzw Ladestrom (oder dem maximal möglichen Wert) geladen. Nach dem Ohmschen Gesetz ergibt sich 
der maximale Ladestrom aus der maximalen Ausgangsleistung, die das Ladegerät ohne Überhitzung 
generieren kann.
Die maximale Eingangsleistung des Ladegerätes beträgt 300W bei einer Eingangsspannung von 15V 
DC.  Die Maximalleistung ist von vielen Faktoren abhängig wie zum Beispiel von ungleich balancierten 
Zellen beim Laden, Eingangsspannung, Ausgangs- bzw. Ladespannung, Wirkungsgrad des DC – DC 
Wandlers (diese variiert zwischen 80% und 90% abhängig vom Verhältnis der Eingangs- zur Ausgangs-
spannung), Umgebungstemperatur sowie der internen Betriebstemperatur.

Peak Power = Maximale Eingangsleistung, die das Ladegerät während der ersten 3 – 5 Minuten des 
Ladevorganges aufnimmt

Wenn der Akku auf etwa 90% seiner Kapazität aufgeladen ist, wechselt das Ladegerät in den „Balance-
Modus“. Der Ladestrom geht zurück, bleibt jedoch im Bereich von 1A oder höher bis die Akku-
spannung den Ladestrom auf 1/20 C (Konstantspannung- Modus) reduziert.  Wenn der Akku  99% 
seiner Kapazität erreicht, signalisiert dies das Ladegerät mit drei „Pieptönen“. Der Akku kann jetzt 
entweder von Ladegerät entfernt und wieder benutzt werden, oder aber bis auf 100% weitergeladen 
werden, bis das Ladegerät auf seinem Display “Charge Complete” (Laden beendet) anzeigt.
Während des gesamten Ladevorganges gleicht das Ladegerät die Einzelspannungen der Akkuzellen mit 
einem Strom von 1A aus (balanciert), bis die Spannungen der Einzelzellen des Akkus weniger als 1mV 
(= 0,001V) voneinander abweichen.  „Power Balancing” wird der Prozess genannt, bei dem schon sehr 
früh während des Ladevorganges der Spannungsausgleich der Einzellzellen beginnt. Mit „Power 
Balancing” können Akkus schneller geladen warden und damit eine erheblich geringere Gesamtladezeit 
benötigt wird. Dies ist durch die im Ladegerät integrierte “Balancer” Elektronik gewährleistet. 
Automatische Temperaturkontrolle und ein interner Ventilator stellen sicher, das das Ladegerät unter 
keinen Umständen überhitzt. Das Ergebnis sind sichere und schnelle Ladezyklen.
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Beim gleichzeitigen Laden von zwei Akkus werden diese mittels vier im Ladegerät integrierter 
electronischer Schalter (Switches)in Serie geschaltet. Ergebnis: Das Ladegerät behandelt die beiden 
Akkus wie einen einzelnen Akku (jedoch jetzt mit entsprechend mehr Einzelzellen). 
Beispiel:  Wenn Sie einen  3S und einen 4S Akku anschließen, so wird das Ladegerät diese als einen 7S 
Akku behandeln. Wenn die Kapazität der einzelnen Akkus unterschiedlich ist, so wird dringend 
empfohlen, den Ladestrom entsprechend des Akkus mit der niedrigeren Kapazität einzustellen, da 
ansonsten der Akku mit der niedrigeren Kapzität beschädigt werden kann. Anfänglich werden beide 
Akkus mit dem eingestellten Ladestrom solange geladen, bis ein Akku vollständig geladen ist. Das 
Ladegerät führt jedoch das Balancieren der beiden Akkus völlig unabhängig voneinander durch. Der 
zweite Akku wird jetzt weiterhin mit einem Strom von 1A geladen, bis er vollständig aufgeladen und 
der Ausgleich der Einzelzellen (Balancing) abgeschlossen ist.
Beachten Sie, dass beim gleichzeitgen Laden einer der beiden Akkus immer mit dem minimalen 
Ladestrom von 1A geladen wird (bedingt durch den maximalen Balancier-Strom).  Wenn die Akkus 
gleiche Kapazität haben und auch etwa gleich stark entladen sind, dann werden beide Akkus in weniger 
als 30 Minuten bei 3C wieder vollständig geladen sein.  Wenn jedoch Akkus unterschiedliche 
Kapazitäten aufweisen oder unterschiedlich entladen sind, so kann der Ladevorgang für ein solches Paar 
erheblich länger dauern als erwartet.  Da das Ladegerät aber einen Balancierstrom von 1A unterstützt, so 
wird das Ladegerät Akkus trotzdem schneller laden als Mitbewerberprodukte dies können. In den meisten 
Fällen ist zu dem Zeitpunkt, an dem der erste Akku vollständig geladen ist auch der zweite Akku bereits 
annähernd voll geladen; der Akku ist der einschränkende Faktor bei der Ladezeit, nicht das Ladegerät.

Beispiel 1:  Sie verwenden in einem Flugmodell zwei in Serie geschaltete 4S 2100mAh 
Akkus.  Da beide Akkus die gleiche Kapazität haben und auch in etwa gleich weit entladen 
wurden, so können Sie davon ausgehen, dass sie auch in der gleiche Zeit wieder geladen 
werden können. In diesem Fall ist es sinnvoll. beide Akkus gleichzeitig mit dem Cellpro 10s 
Ladegerät zu laden.
Beispiel 2: Sie verwenden in einem Flugmodell einen 3S 500mAh Akku und in einem 
anderen Modell einen 5S 5000mAh Akku.  Wenn Sie diese beiden Akkus gleichzeitg mit dem 
Cellpro 10s Charger laden, wird der Ladevorgang wahrscheinlich sehr lange dauern (der 
500mAh Akku wird als Erster geladen sein, danach schaltet das Ladegerät auf den 1 A 
Balanciermodus, um jetzt den 5000mAh Akku zu laden, was mehrere Stunden dauern kann). 
In diesem Fall ist es günstiger und vor allem schneller, beide Akkus jeweils getrennt und 
einzeln zu laden, weil das Ladegrät in diesem Fall für beide Akkus die optimalen (und 
unterschiedlichen) Werte zum Laden verwenden kann.

In manchen Fällen können wie im Beispiel 2 zwei Akkus einzeln schneller geladen werden anstatt sie 
gleichzeitig zu laden. Es liegt an Ihnen und Ihrem Wissen über die jeweilige Kapazität und den 
Entladezustand zu entscheiden, ob Sie die Akkus einzeln oder gleichzeitig laden wollen.

Das “Cellpro 10s” Ladegerät verfügt über die “FMA Fuel Gauging“ Technologie. Während aller Phasen 
des Ladevorganges wird das Ladegerät die Kapazität beider zu ladender Akkus unabhängig voneinander 
anzeigen.  Im obigen Beispiel 2 können Sie den 500 mAh Akku nach Erreichen von 99% Kapazität 
(angezeigt durch drei Piepöne) einfach vom Ladegerät abklemmen und den 5000 mAh Akku mit einem 
höheren Ladestrom weiterladen.  Und so wird es gemacht:
1. Schließen Sie beide Akkus an und starten den Ladevorgang im Automatik-Modus (1C , 2C oder 3C 

ausgewählt).
2. Beobachten Sie die Anzeige des Ladezustandes. Wenn ein Akku zu 99% geladen ist (wird durch drei 

„Pieptöne“ angezeigt), beenden Sie den Ladevorgang (Drücken der Stop Taste).
3. Klemmen Sie den geladenen Akku vom Ladegerät ab.
4. Falls der nur teilweise geladene Akku am Kanal 2 (Channel 2) angeschlossen war, so schließen Sie 

ihn jetzt an Kanal 1 (Channel 1) an.
5. Laden Sie den bereis teilweise geladenen Akku weiter (Start-Taste drücken).
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Begrenzung des Eingan gstroms für das Ladegerät:
Das Ladegerät zieht bis zu 25A aus demNetzgerät oder der Autobatterie, um den maximalen Ausgangs- / 
Ladestrom zur Verfügung zu stellen. Dieser hohe Eingangsstrom ist erforderlich um Akkus mit einer 
höheren Zellenzahl zu laden. Die Algorithmen des Ladegerätes basieren auf Leistung (Watt), nicht auf 
Strom (A) alleine. Das Ladegerät benötigt bei Beginn des Ladevorgangs bis zu 300W, der Leistungsbedarf 
wird jedoch automatisch in Abhängigkeit von der Innentemperatur des Ladegerätes reduziert. Die 
Ausgangsleistung hängt von verschiedenen Faktoren ab, diese schließen ein: Unterschiedliche 
Einzelzellenspannung beim Laden, Eingangsspannung und -Strom, Ausgangsspannung, 
Umgebungstemperatur und die interne temperatur des Ladegerätes.
Der DC-zu -DC Konverter des Ladegerätes hat einen Wirkungsgrad von typisch 80% bis 90%. Der 
höchste Wirkungsgrad tritt dann auf, wenn die Eingangsspannung höher ist als die zum Laden des 
angeschlossenen Akkus benötigte Ausgangsspannung.  Die maximale Eingangssapnnung beträgt 16V 
DC. Bei 15V Eingangsspannung wird der beste Wirkungsgrad erreicht, damit die geringste 
Verlustleistung, geringste Erwärmung und kürzeste Ladezeiten besonders dann, wenn mehr als 5S 
Akkus (5 und mehr Einzelzellen in Serie geschaltet) geladen werden sollen.
Um ein Netzteil mit weniger als 25A Ausgangsstrom nicht zu überlasten, können Sie jedoch den 
Eingangsstrom des Ladegerätes begrenzen.  Wenn Ihr Netzteil z.B. 3A als Ausgangsstrom liefern kann, 
so können Sie dem maximalen Eingangsstrom des Ladegerätes ebenfalls auf 3A begrenzen.. Denken Sie 
jedoch daran, dass die Begrenzung des Eingangsstroms für das „Cellpro 10s“ Ladegerät zu längeren 
Ladezeiten führen kann!  Wenn das Ladegerät jedoch an einer sehr leistungsfähigen Stromquelle wie 
zum Beispiel einer Autobatterie angeschlossen ist, so können Sie den Wert für die Strombegrenzung 
überschreiben und damit den maximalen Ladestrom für den betreffenden Akku erreichen.  Details 
hierzu finden Sie in dem Abschnitt “Begrenzung des Eingangsstroms” in dem Kapitel “ Benutzung der 
Ladekontrollsoftware (Charge Control SW) in diesem Handbuch.

Ansc hluss der Akkus an das Ladegerät:

Allgemeine Informationen
 Wenn ein Akku zusätzlich zu den normalen  Anschlusskabeln über eine Balancer-Anschluss verfügt, 

so können Sie den Akku entweder nur über den Balancer-Anschluss oder aber auch über beide 
(Anschluss- und Balancerkabel) laden. Wenn zwei Akkus gleichzeitig geladen werden sollen so 
müssen beide auf die gleiche Art angeschlossen sein: Entweder nur  über die Balanceranschlüsse oder 
aber über die Anschlusskabel und  die Balanceranschlüsse!
 Beim Laden nur über den Balanceranschluss gleicht das Ladegerät gleichzeitig die Einzelzellen-

spannungen aus (wird Balancing genannt). In diesem Fall ist der maximale Ladestrom auf 4A 
begrenzt, um die Leitungen des Balanceranschlusses nicht zu überlasten.

 Bei Laden über die normalen Anschlüsse des Akkus und den Balanceanschluss gleicht das 
Ladegerät gleichzeitig die Einzelzellenspannungen aus und misst zusätzlich den Innenwiderstand 
jeder Einzelzelle eines Akkus. Der maximale Ladestrom ist in diesem Falle nicht auf 4A begrenzt.

 Wenn Sie nur einen Akku laden, schließen Sie ihn immer an den Kanal 1 (CH1) des Ladegerätes an.
 Wenn Sie nur einen Akku sowohl über die Anschlusskabel als auch den Balanceranschluss laden, 

dann schließen Sie die Anschlusskabel des Akkus an die beiden äußeren Buchsen des Ladegerätes an.
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 Wenn Sie einen oder zwei Akkus nur über die Balanceranschlüsse laden, so müssen Sie  den “Plug 
Blocker” Adapter in die Buchsen des Ladegerätes stecken.

 Wenn Sie zwei Akkus gleichzeitig laden wollen, so müssen diese vom gleichen Typ (Chemistry) sein. 
Sie können zum Beispiel keinen  A123 Akku zusammen mit einem LiPO Akku gleichzeitig laden.

 Die Anschlussleitungen eines Akkus sind üblicherweise nicht mit Bananensteckern versehen. Zum 
einfachen Anschluss an das Ladegerät sollten Sie sich ein entsprechendes Adapterkabel erstellen / 
erwerben, das auf der einen Seite mit Bananenstecker hat und auf der anderen Seite mit dem für Ihren 
Akkus passenden Anschlüssen versehen ist. Entsprechende Stecker sind im Elektronik- oder 
Modellbauhandel erhältlich.

Achtung  :    Wenn Sie Adapterkabel mit Bananensteckern verwenden, schließen Sie das Kabel mit den 
Bananensteckern zuerst an dem Ladegerät an,  BEVOR Sie das Anschlusskabel mit dem Akku verbinden. 
Bei Trennen des Akkus vom Ladegerät UNBEDINGT in umgekehrter Reihenfolge vorgehen, zuerst das 
Akku Anschlusskabel austöpslen, erst DANACH die Bananenstecker am Ladegerät ziehen!! Damit 
verhindern Sie, dass sich u.U. die Bananenstecker des Anschlusskabels berühren und einen Kurzschluss 
hervorrufen. Dieser Kurzschluss kann zur Beschädigung der Anschlussleitungem und des Akkus führen. 
Auch ein Brand oder die Explosion ist durch die hohe Energiedichte des Akkus dann nicht ausge-
schlossen.

Anschluss von “Nicht Cellpro” Akkus, d.h. Akkus mit anderen Anschlüssen
Befolgen Sie unbedingt die Hinweise imAbschnitt “Anschluss von 1S – 10S Cellpro Akkus” und 
“Anschluss von zwei 1S – 10S Cellpro Akkus“. Allerdings sind die von Ihnen benutzten Akkus 
möglicherweise nicht mit passenden Balanceranschlüssen ausgerüstet.  Zum Laden von LiPo Akkus 
anderer Hersteller mit abweichenden Balanceranschlüssen sind passende Adaper zum Anschluss an das 
„Cellpro 10s“ Ladegerät bei Parkflieger erhältlich. Details und entsprechende Produkte finden Sie auf 
der Parkflieger WEBSeite: http://www.parkflieger.de/Ladegeraete/Zubehoer-Balancer:::90_92.html. 
Das „Cellpro 10s” Ladegerät funktioniert mit allen bereits vorhandenen Cellpro 4S Adaptern.  Sie 
müssen dazu einen „ 6 Pin-zu -5 Pin Adapter (im Lieferumfang des “Cellpro 10s“ Ladegerätes 
enthalten) zwischen dem Ladegerät  und dem Cellpro 4s Ladeadapter wie nachfolgend gezeigt 
anschließen:

Sollte für Ihre Akkus kein geeigneten Adapter verfügbar sein oder aber Ihr LiPo Akku verfügt über 
keinen Balancer Anschluss, die FMA Teilenummer CPBP7 (Cellpro battery pigtail 10”, 5 position) und / 
oder FMA Teilenummer CPBP6P-10 (Cellpro battery pigtail 10”, 6 position) Anschlusskabel können 
dazu benutzt werden, Ihre(n) Akku(s) an das “Cellpro 10s” Ladegerät  anschließbar zu machen. 
Anleitungen zum Anschluss dieser Teile an Ihren Akku fimdem Sie in dem Dokument “Cellpro Pin Lead 
Connection” auf  www.fmadirect/support_docs/item_1254.pdf.  Siehe auch „Verdrahtung von 
Balancerkabeln” spatter in diesem Handbuch.

Anschluss eines   1S bis 10S Cellpro Akkus
1. Der Anschluss des Balancerkabels eines Cellpro Akkus an das Ladegerät hängt von der 

Konfiguration des Akkus ab, d.h. der Anzahl der Einzelzellen des Akkus. Identifizieren in den 
nachfolgenden Diagrammen zuerst die Konfiguration Ihres Akkus. Anschließend verbinden Sie den 
Akku entsprechend des jeweilgen Beispiels
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2. Wenn Sie die Anschlusskabel des Akkus zum Laden eines einzelnen Akkus verwenden, so schließen 
Sie die beiden Kabel in die äußeren  Buchsen (Richtige Polarität beachten: Plus an Plusbuchse des 
Laders – rechts und Minus an Minusbuchse des Laders – links!!)

oder
Wenn Sie die Akku Anschlusskabel nicht benutzen, dann stecken Sie bitte in die beiden äußeren 
Buchsen den “Plugblocker”.
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Anschluss  von  zwei  1S bis 5S Cellpro Akkus                                                                          
1. Der Anschluss der Balancerkabel der jeweiligen Cellpro Akkus an das Ladegerät hängt von der 

Konfiguration der Akkus ab, d.h. der Anzahl der Einzelzellen des Akkus. Identifizieren in den 
nachfolgenden Diagrammen zuerst die Konfiguration Ihrer beiden Akkus. Anschließend verbinden 
Sie die Akkus entsprechend des jeweilgen Beispiels.

2. Wenn Sie die Anschlusskabel der Akkus zum Laden der beiden Akkus verwenden, so schließen Sie 
die beiden Kabelpaare wie nachfolgend gezeigt an (Richtige Polarität beachten: Plus an Plusbuchse 
des Laders – rechts und Minus an Minusbuchse des Laders – links!!)

oder
Wenn Sie die Akku Anschlusskabel nicht benutzen, dann stecken Sie bitte in die beiden äußeren 
Buchsen den “Plugblocker”.
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Anschluss der Stromversorgung an das Ladegerät

 Schließen Sie das Ladegerät an ein Netzteil mit einer Ausgangsspannung von 12V bis 15V DC 
(= Gleichspannung) oder an einen 12V Akku oder die Autobatterie an.  Wenn Ihr Netzteil über 
Buchsen für Bananenstecker verfügt, dann entfernen Sie die beiden Polklemmen von den 
Anschlusskabeln des „Cellpro 10s“ Ladegerätes und schließen das Ladegerät direkt mit den 
Bananensteckern an das Netzteil an.. 
Achten Sie unbedingt auf die korrekte Polarität: Rot = Plus, Schwarz = Minus

Beim Einschalten des Ladegeräts werden auf dem LCD Display die folgenden Informationen 
nacheinander angezeigt:

FMA Cellpro 10s
[firmware version]*

2 Packs Charge
[chem]* Set @ [charge current]*

SAFE TO CONNECT
Press START

*Information in [] ist verschieden, z.B. LiPo oder A123 und 1C (Ladestrom).

Werksseitige Einstellungen
Ab Werk sind folgende Werte im „Cellpro 10s“Ladegerät  voreingestellt:
 2 Packs Charge, LiPo Set @ 1.0C (Zwei Akkus laden, Akkutyp: LiPo, Ladestrom = 1C) 

 1 Pack Charge, LiPo Set @ 1.0C  (Einen Akku laden, Akkutyp: LiPo, Ladestrom = 1C)

Wenn die Stromversorgung für das Ladegerät eingeschaltet wird, so wird es immer mit zuletzt 
eingestellten Werten zum Laden initialisiert.  Hinweise für “Selecting a Preset” (Auswahl eines Preset) 
in einem nachfolgenden Kapitel zeigen, wie zwischen den beiden Presets umgeschaltet werden kann. 
Diese Einstellungen bleiben erhalten, auch wenn das Ladegerät ausgeschaltet ist und werden beim 
nächsten Einschalten automatisch erneut aktiv.

Weitere Informationen hierzu sind unter “Selecting a Preset” und “Changing a Preset,” (Auswahl und 
Änderung eines Presets) im nächsten Abschnitt enthalten.

In allen nachfolgenden Anweisungen und Erklärungen wird die Originalbezeichnung „Preset“ anstelle 
von „Voreinstellung“ verwendet.

Hinweis :  Wenn Sie das Ladegerät mit der Charge Control Software programmiert haben, können 
zusätzliche Prests verfügbar sein. Ebenso können Sie mit der Software den Presets andere Namen 
geben. Daher werden eventuell andere als die oben gezeigten Presets angezeigt.
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Bedienung des Ladegerätes

Mit den beiden Tastern Mode  und Start / Stop  auf der rechten Seite wird das Ladegerät bedient
 Mode Taster:  Damit wählen Sie ein Preset aus, können das ausgewählte Preset ändern und 

auswählen, welche Werte beim Laden des Akkus auf dem LCD Display angezeigt werden.
 Start/Stop  Taster:  Mit diesem Taster können Sie den Ladevorgang nach Auswahl des 

entsprechenden Presets starten und ebenso den Ladevorgang zu einem beliebeigen Zeitpunkt 
abbrechen bzw. beenden.

Mit diesen beiden Tastern können Sie:
 Eine Preset auswählen (siehe: „Auswahl eines Presets”).
 Die Ladeparameter für ein beliebiges Preset ändern (siehe: „Ändern eines Presets).
 Den oder die angeschlossenen Akkus laden und sich die Betriebsdaten in Echtzeit (Real tine) 

während des Ladevorganges ansehen (siehe: „Akku(s) Laden”).

Auswahl eine s Presets
 Zur Anzeige des momentan ausgewählten Presets und Überprüfung der darin festgelegten Parameter:  

Drücken Sie die „Mode“  Taste auf der rechten Seite des Ladegerätes.
 Auswahl eines anderen Presets:   Drücken Sie den Mode Taster so lange, bis der Name des 

gewünschten Presets und dessen Parameter auf dem LCD Display angezeigt werden, danach warten 
Sie, bis die Anzeige  „Safe to Connect“ erscheint.

Dasjenige Preset, welches beim Loslassen des Mode Tasters angezeigt wird, ist dann das ausgewählte 
Preset (selected Preset).  Nachdem der Auswahl eines Preset können Sie die Ladeparameter für dieses 
Preset ändern (siehe: “Ändern eines Preset”) oder aber den Ladevorgang durch Drücken des „Start/Stop“  
Tasters beginnen.

Hinweis :  Mit der Charge Control Software können Sie bis zu 6 verschiedene Presets mit eigenen 
Einstellungen definieren.  Nachdem Sie diese Ihren Erfordernissen entsprechenden Presets definiert 
haben, können Sie—jetzt direkt am Ladegerät—ein beliebiges Preset auswählen.  Wenn Sie keine 
eigenen Prests definiert haben, stehen Ihnen nur die zwei werksseitig erstellten  Presets zur Verfügung.

Ändern eine s Presets
Sie können die Ladeparameter des von Ihnen ausgewählten Presets an die Charakteristik des/der zu 
ladenden Akkus anpassen.

Hinweis :  Änderungen, welche Sie an einem Preset vornehmen, warden im Ladegerät gespeichert, wenn 
Sie es von der Stromversorgung trennen. Damit stehen diese Werte direct nach dem erneuten Anschluss 
an eine Stromquelle wieder zur Verfügung..

1. Wählen Sie das zu ändernde Preset aus (siehe oben: „Auswahl eines Presets”).
2. Jetzt können die einzelnen Parameter wie z.B. Akkutyp, Spannung, Ladestrom, etc. ändern bzw. an 

die zu ladenden Akkus anpassen:
 Ändern der “Chemistry”, d.h. des Akkutyps (LiPo, LiIon, A123):

a. Drücken und halten Sie den Mode Taster gedrückt. Lassen Sie ihn los, sobald das LCD Display 
auf folgenden Text wechselt:

Choose Chemistry
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Hold for More

Hinweis :  Wenn Sie den Mode Taster länger gedrückt halten, so wird die Nachricht „Choose Chg. 
Amps or Exit” angezeigt (beides nachfolgend beschrieben).

Wenn den Mode  Taster loslassen, wird die ausgewählte „Chemistry“ = Akkutyp angezeigt:

Choose Chemistry
[chemistry] @[voltage]

b. Betätigen Sie den Mode Taster so oft, bis die von Ihnen gewünschte “Chemistry” = Akkutyp 
angezeigt wird.  Zur Auswahl stehen:
 Lithium Poly 4.20V
 Lithium Ion 4.20V
 Lithium Ion 4.10V
 A123 3.65V

 Zum Ändern des Ladestroms:
a. Drücken und halten Sie den Mode Taster gedrückt. Lassen  Sie ihn los, sobald  die Anzeige auf 

folgenden Text wechselt: 

Choose Chg. Amps
Hold for More

Hinweis :  Wenn Sie den Mode Taster länger gedrückt halten, wird , wird “Exit“ angezeigt (nachfolgend 
beschrieben) oder Choose Chemistry (wie bereits oben beschrieben).
Wenn Sie den Mode  Taster loslassen, wird der augenblicklich eingestellte Ladestrom angezeigt:

Choose Chg. Amps
Charge @ [current]

b. Danach:
 Drücken Sie Mode  Taster in etwa 1x pro Sekunde, um den Ladestrom in 0,1A Schritten zu 

erhöhen.
 Drücken Sie den Mode  Taster zweimal schnell hintereinander, um den Ladestrom auf den 

nächsten vollen Amperewert zu erhöhen.
 Wenn der Maximalwert erreicht ist, drücken Sie den Mode  Taster einmal für jeden der drei 

nachfolgenden Auto-Lademodi oder den „Storage“ Lademodus:
 1.0C (wobei C = Kapazität des Akkus)
 2.0C
 3.0C
 Store (Hierbei wird der Akku auf etwa 50% seiner Kapazität aufgeladen, dieser 

Lademodus sollte zur Lagerung des Akkus verwendet werden, z.B. wenn Sie den Akku in 
der Winterpause längere Zeit nicht verwenden)

 (Zurück zum Anfang, Ladestrom auf 0,1A setzen)

Hinweis :  Die im Ladegerät gespeicherten Tabellen für den Ladevorgang sind für Lithium Cobalt Zellen 
optimiert. Wenn Sie Lithium Mangan Zellen laden wollen, kann der Ladevorgang im Automatikmodus 
doppelt so lange wie erwartet dauern. Zum Laden von Lithium Mangan Zellen wird daher die manuelle 
Einstellung des Ladestroms empfohlen.
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 Zum Abspeichern Ihrer Eingaben und um zum Anfang (Home Screen) zurückzukehren:  Drücken 
und halten Sie den Mode Taster gedrückt, bis das LCD Display auf folgende Anzeige wechselt::

Exit
Hold for More

Hinweis :  Wenn Sie jetzt den Mode Taster länger gedrückt halten, wird erneut die Anzeige „Choose 
Chemistry“ oder „Choose Chg. Amps” im Display erscheinen (Beides bereits oben 
beschrieben).

oder
Zum Sichern der Einstellungen und zum Beginnen des Ladevorganges wenn  bereits ein Akku am  
Ladegerät angeschlossen ist :  Drücken Sie den Start/Stop  Taster auf der rechten Seite des 
Ladegerätes.  Details dazu sind im nächsten Abschnitt beschrieben.

Akku(s) Laden
1. Vergewissern Sie sich, dass vor Beginn des Ladevorgangs der/die zu ladenden Akku(s) richtig mit 

dem Ladegerät verbunden sind. Details finden Sie weiter oben unter „Anschluss der Akkus an das 
Ladegerät“.

2. Zum Starten des Ladevorgangs drücken Sie den Start/Stop  für etwa 1 Sekunde.
3. Jetzt werden nacheinander folgende Informationen im LCD Display angezeigt:

Checking Pack(s)

CHARGING   Press
MODE for info.

4. Während des Ladevorgangs können Sie folgende Information abrufen und auf dem LCD Display 
anzeigen:
 Anzeige des Akku-Typs und der augenblicklichen Betriebsdaten :  Drücken Sie wiederholt den 

Mode Taster, um von einer Anzeige auf die Nächste weiterzuschalten.  (Die nachfolgenden 
Beispiele gehen davon aus, dass zwei Akkus geladen warden. Wenn nur ein Akku geladen wird, 
erscheint bei einigen Anzeigen nur die obere Zeile .)

C 0.5A 00:00:59
Supply=13.8V/ 1A

Ladestrom und Ladezeit.
Versorgungsspannung und Eingangsstrom

[preset name]
[chem] Set @ [charge current]

Ausgewähltes Preset.
Zugehörige Ladeeinstellungen.

Ch1 [chemistry] [charge process]
Ch2 [chemistry] [charge process]

Chemistry (Akku Typ) & Ladeart (Fast 
Charging/Schnellladung, Balance 
Charging/Balancieren, etc.) für jeden 
Kanal.
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Ch1 Fuel = 47%
Ch2 Fuel = 55%

Ergebnis des FMA-eigenen Algorithmus zur 
Bestimmung des Akku Ladezustands. Diese 
Daten dienen auch zur Bestimmung der korrekten 
C Rate beim Laden des Akkus  im 1/2/3C 
Automatikmodus .

Ch1 Pack = 11.754V
Ch2 Pack = 11.821V

Spannung (V) des gesamten Akkus.

Ch1    42mAh In
Ch2    40mAh In

mAh während des Ladevorgangs in den 
Akku geladen.

1:3.835V 2:3.955V
3=3.959V 4=3.873V

Spannung der Einzelzellen.*  “:” bedeutet 
CH1, “=” bedeutet Ch2.  Die Anzeige hängt 
von der Anzahl der Einzelzellen eines 
Akkus beim Laden ab.

1:23.3mΩ  2:17.1
3=12.1mΩ  4=25.7

Innenwiderstand der Einzelzellen in Milli-
ohm.*†  “:” bedeutet Ch1, “=” bedeutet 
Ch2.  Die Anzeige hängt von der Anzahl 
der Einzelzellen eines Akkus beim Laden 
ab.

*Hinweis: Die Einzelzellen eines akkus warden von 1 bis “n” durchnummeriert, wobei 1 für die erste Zelle und “n” für die 
letzte Zelle eines an CH1 (Kanal1) angeschlossenen Akkus steht (wenn nur ein Akku geladen wird) Beim Laden von zwei 
Akkus an CH1 und  CH2 beschreibt „n“ die letzte Zelle des Akkus an Ch2 (Kanal2).

†Wenn das Ladegerät den Innenwiderstand messen soll, so müssen:
a) Die Akku-Anschlusskabel während des Ladevorgangs zusätzlich zu den Balancekabeln angeschlossen sein

und
b) Der Akku muss weniger als 80% seiner Gesamtkapazität aufweisen.  
Die Innenwiderstände aller Einzelzellen eines Akkus werden nach etwa 12 Minuten auf dem LCD Display angezeigt und 
danach in regelmäßigen Abständen den momentatnen Werten entsprechend angepasst.

 Ladevorgang beenden:   Drücken Sie den Start/Stop  Taster für eine Sekunde. Das Ladegerät zeigt 
dann auf dem LCD Display wieder folgende Nachricht an: „Save to Connect, Press Start“

Hinweis :  Alle Akkudaten gehen verloren, wenn Sie den Lademodus verlassen. Wenn Sie sich die Daten 
ansehen wollen, so müssen Sie dies vor  dem Drücken des  Start/Stop  Tasters tun.

Hinweis :  Wenn Sie den Ladevorgang erneut starten, so kann eine Please wait... (Bitte Warten) 
Nachricht angezeigt werden   Das Ladegerät entlädt gerade Kondensatoren, dies kann bis zu 1 Minute 
dauern. Wenn die Re-Initialisierungsphase abgeschlossen ist, wird der Ladevorgang erneut gestartet.
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5. Wenn der Ladevorgang abgeschlossen ist wird folgende Nachricht angezeigt und das Ladegerät wird 
Sie für die Dauer von 30 Sekunden mit einem Piepton darüber informieren.

Ch1 [chemistry] DONE
Ch2 [chemistry] DONE

 Zum Anzeigen der Ladedaten für den/die Akkus:  Drücken Sie zur Anzeige aller Daten den Mode  
Taster (pro Tastendruck eine Anzeige).

Hinweis:   Alle Akkudaten gehen verloren, wenn Sie den Lademodus verlassen. Wenn Sie sich die Daten 
ansehen wollen, so müssen Sie dies vor  dem Drücken des  Start/Stop  Tasters tun.

  Zum Verlassen des Lademodus: Drücken Sie den Start/Stop  Taster.

Weitere Lademethoden
Abhängig davon, was das Ladegerät als den geeignetsten Lademodus bestimmt, kann eine der 
nachfolgenden  Lademethoden ausgewählt werden (wird im LCD Display angezeigt):
 Im “Low Voltage Restore Mode”  versucht das Ladegerät, automatisch, tiefentladene Zellen eines 

Akkus zu reparieren. Zellen eines Akkus, die sogar bis auf 0.5V tiefentladen wurden, können auf bis 
zu 98% ihrer ursprünglichen Kapazität wiederhergestellt werden.

 Im “Safety Charging Mode” , entdeckt das Ladegerät, dass die Spannung mindestens einer Zelle des 
Akkus erheblich von den anderen Zellen abweicht und reduziert daher den Ladestrom auf 0.5A.

Vorsicht  :    Wenn das Ladegerät die Nachricht “SAFETY CHARGING” bei mehreren Ladeversuchen 
anzeigt, so ist der Akku mit größter Wahrscheinlichkeit beschädigt. Handhaben Sie beschädigte Akkus mit 
größter Vorsicht. Legen Sie den Akku beim Laden nicht auf eine brennbare Oberfläche und lassen Sie ihn 
während des Ladevorgangs nicht unbeaufsichtigt!!

 Im “Cold Weather Balancing Mode” (Balancieren bei niedrigen Temperaturen) wird der Lade-
vorgang bei Temperaturen von weniger als etwa 12°C (55°F) automatisch beendet, wenn eine 
Spannung von 4.10V/Zelle erreicht ist. Damit wird eine Beschädigung der Zellen und damit des 
Akkus beim Laden unter niedrigen Umgebungstemperaturen vermieden.
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Wichtiger Hinweis : Wenn das Ladegerät ein Problem entdeckt, so wird es den Ladevorgang abbrechen und einen 
Sicherheitscode (Safety code) anzeigen. In diesem Fall gehen Sie wie folgt vor:

1. Bestimmen Sie anhand des Codes die mögliche Fehlerursache (Diese Codes finden Sie im Kapitel 
„Fehlersuche“ am Ende dieser Broschüre) 

2. Drücken Sie den Mode Taster  zum Zurücksetzen (Reset) des Ladegerätes
3. Verbinden Sie erneut den Akku mit dem Ladegerät. Achten Sie auf korrekten Anschluss!
4. Drücken Sie den Start/Stop  Taster , um den Ladevorgang fortzusetzen



Benutzung der “ Charge Control” Software

Mit der „Cellpro 10s Charge Control” Software können Sie eigene Presets definieren und speichern sowie 
Preset-Gruppen laden, die Firmware des Ladegerätes auf den neuesten Stand bringen (Update) und 
verschiedene Optionen des Ladegerätes kontrollieren.

Installation der “Charge Control” Software
1. Starten Sie an Ihrem PC mit einem Windows Betriebsystem (vorzugsweise Windows XP) den 

Internet Explorer und rufen Sie folgende WEB-Adresse auf:
http://www.fmadirect.com/new_applications/CellPro10S_Software/setup.exe

2. Befolgen Sie die auf Ihrem Bildschirm angezeigten Anweisunge. Die Software wird heruntergeladen, 
installiert und gestartet.

*Falls Sie einen anderen Internet Browser als den Internet Explorer verwenden und ein Problem auftritt, so definieren Sie 
vorübergehend den Internet Explorer zum Standard Browser auf Ihrem PC. Gehen Sie wie folgt vor:
1.Start > Settings > Control Panel .
2. Dort Doppelklick auf Add or Remove Programs .
3. Im Add or Remove Programs  Dialog, klicken Sie auf  Set Program Access and Defaults auf der linken Seite .
4. Öffnen Sie das Panel Custom 
5. Unter Choose a default Web browser , klicken Sie auf  Internet Explorer .
6. Bestätigen Sie mit OK.
7. Schließen Sie das Add or Remove Programs  und das Control Panel  Fenster.
Nach der Installation der Charge Control Software können Sie wieder Ihren bisherigen Webbrowser aktivieren.

Starten der  Charge Control Software
1. Start > All Programs > FMA Direct > Cellpro 10s.
2. Wenn Ihr Computer zu diesem Zeitpunkt mit dem Internet verbunden ist, wird die Software 

überprüfen, ob eine neuere Version verfügbar ist. In diesem Fall haben Sie die Möglichkeit, entweder 
die neue Version zu installieren oder aber die bereits installierte Version zu starten.

3. Wenn Ihr Computer zum Zeitpunkt des Programmstarts mit dem Internet verbunden ist, wird die 
“Charge Control Software” überprüfen, ob es eine neuere Firmware-Version für Ihr Ladegerät 
vorhanden ist. Wenn neue Firmware verfügbar ist, wird eine Benachrichtigung erscheinen. Klicken 
Sie auf „OK”, um dieses Fenster zu schließen. Details zum Firmware Update sind im Abschnitt 
„Firmware Update“ weiter unten in diesem Handbuch beschrieben.

Anschluss des Ladegerätes an Ihren Computer
1. Stecken Sie den 3-poligen Stecker des FUIM2 Verbindungskabels in die Buchse auf der linken Seite 

des Ladegerätes. Die schwarze Leitung des Kabels sollte unten zeigen (Vorderseite des Ladegerätes).
2. Schließen Sie den USB Stecker des FUIM2 Kabels an Ihrem Computer an.
3. Wenn die “Charge Control Software” noch nicht gestartet ist, so starten Sie das Programm jetzt.
4. Achten Sie auf die “Message” Zeile direkt unterhalb der Menüzeile des Programms.

 Wenn dort die Nachricht “Waiting to Start” erscheint, funktioniert alles einwandfrei und Sie 
können das Programm jetzt benutzen.

 Wenn aber die Nachricht “Checking Com COMx for data” nicht verschwindet, so kann das 
Programm nicht mit dem Ladegerät kommunizieren.  Um dieses Problem zu beheben, führen Sie 
die nachfolgenden Schritte zur Installation des USB Einheitentreibers (Device Driver) durch:
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a. Klicken Sie auf “Download USB Driver”  unten im “Charge Control Software“ Fenster.
b. Starten Sie das Installationsprogramm für den USB Einheitentreiber.
c. Starten Sie Sie Ihren Computer neu (Restart).

Überwachung von Ladevorgängen
 Zur Kontrolle der Zellenspannungen, der Gesamtspannung des Akkus und der zugehörigen 

Ladeparameter während des Ladevorgangs :  Klicken Sie „Cells“  an.
 Zur Kontrolle des Zellen-Innenwiderstandes während des Ladevorganges :  Klicken Sie „Int. Res.“  

an.

Hinweis:   Damit das Ladegerät die Innenwiderstände messen kann:
a) Müssen die Akku-Anschlusskabel während des Ladevorgangs zusätzlich zu den Balancekabeln angeschlossen sein

und
b) Der Akku muss weniger als 80% seiner Gesamtkapazität aufweisen. Die Innenwiderstände aller Einzelzellen eines Akkus 
werden nach etwa 12 Minuten auf dem LCD Display angezeigt und danach in regelmäßigen Abständen den momentatnen 
Werten entsprechend angepasst.

 Grafische Darstellung der Zellenparameter:   View > Graphs .  Im “Graphs” Fenster:
 Spannung:  View > Volts .
 Strom:  View > Amps .
 Innenwiderstand:  View > Internal Resistance .
 Ladezustand:  View > Fuel .
 Drucken einer Grafik:  File > Print .

Begre nzen des maximalen Eingangsstroms für das ladegerät
Das Ladegerät zieht bis zu 25A für seinen maximalen Ausgangsstrom von 10A.  Dieser hohe 
Eingangsstrom wird benötigt, um die Eingangsspannung auf die von Akkus mit vielen in Serie 
geschalteten Einzelzellen benötigte Ladespannung anzuheben. Das Ladegerät überwacht den vom 
Netzteil gelieferten Eingangsstrom und reduziert automatisch den Ladestrom für den Akku, wenn es 
feststellt, dass das Netzteil den notwendigen Eingangsstrom nicht liefern kann, d.h. zu schwach ist.
Der maximale Eingangsstrom kann auch manuell begrenzt warden, damit das Ladegerät nicht mehr 
Strom zieht, als das Netzteil liefern kann.  Wenn Sie wissen, dass Ihr Netzteil z.B. maximal 3A abgeben 
kann, so können Sie auch den maximalen Eingangsstrom des Ladegerätes auf 3A begrenzen. Damit 
vermeiden Sie eine Überlastung und mögliche Beschädigung des betreffenden Netzteils. Denken Sie 
jedoch daran, dass die Begrenzung des Eingangsstroms die Akku-Ladezeit verlängern kann.  Wenn das 
Ladegerät jedoch von einem Netzteil oder einer anderen Stromquelle mit ausreichend hoher 
Belastbarkeit (z.B. Autobatterie) mit Strom versorgt wird, so können Sie die Strombegrenzung manuell 
überschreiben, damit wieder der maximale Akku-Ladestrom zur Verfügung steht.
 Kontrolle der Eingangsspannung:   Klicken Sie  “Supply” an .
 Manuelle Begrenzung des Eingangsstroms:  

1. Wählen Sie im  “Supply  tab” den gewünschten Maximalstrom aus der “Current Limit” Liste aus .
2. Klicken Sie dann “Update Charger” an .

 Manuelles Aufheben der Eingangsstrombegrenzung auf dem Modellflugplatz ohne Verwendung der 
„Charge Control“  Software:
1. Drücken Sie den Mode Taster am Ladegerät und halten ihn gedrückt.
2. Verbinden Sie jetzt die Anschluskabel des Ladegerätes mit der Stromquelle (z.B. Autobatterie).
3. Sobald die ersten Zeichen auf dem LCD Display angezeigt werden, lassen Sie den Mode Taster los.
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Hinweis : Wenn der Eingangsstrom des Ladegerätes manuell begrenzt wurde, das Ladegerät aber den 
vollen Eingangsstrom ziehen soll, so müssen Sie die obige Prozedur jedesmal wiederholen, wenn Sie das 
Ladegerät erneut an eine Stromquelle anschließen.

Definiti on von Presets
Sie können Presets für bis zu 6 veschiedenen Ladekonfigurationen definieren.  Jedes „Preset“ wird durch 
einen Namen beschrieben und beschreibt einen Akkutyp (hier „Chemistry“) und den dazugehörigen 
Ladestrom. Um ein Preset zum Laden auswählen, lesen Sie bitte unter “Auswahl eines Presets“  nach, wie 
bereits weiter oben in dieser Broschüre beschrieben.

Hinweis :  Denken Sie daran, dass Presets direkt am Ladegerät überschrieben bzw. modifiziert werden 
können. Und im Ladegerät erhalten bleiben, bis sie entweder erneut am Ladegerät verändert werden oder 
aber eine neue Gruppe von Presets auf das Ladegerät heruntergeladen wird.  Wenn Sie das Ladegerät 
mit Ihfem PC verbinden und die “Charge Control” Software starten, zeigt dsas Programm Ihnen die im 
Ladegrät gespeicherten Presets an.

Führen Sie Schritte zur Erstellung, Bearbeitung und Übertragung von Presets in dem „Preset“ Fenster 
durch.
 Definition eines neuen Presets:

1. Im “Name”  Feld geben Sie den Namen für diese Preset ein.
2. Im “Chem” Feld wählen Sie die “Chemistry”.aus, d.h. den zugehörigen Akkutyp.
3. Im “Amps” bestimmen Sie den Ladestrom des unter Punkt 2 definierten Akkutyps.
4. Wenn dieses Preset zum Laden eines 6s bis 10s Akkus benutzt warden soll, so aktivieren Sie die 

Option “Single Pack “ (Einzelakku). Damit behandelt das Ladegerät die beiden Ladekanäle  
Ch1 und Ch2 als einen gemeinsamen Kanal.

 Zur Übertragung (download) von Presets zum Ladegerät: Klicken Sie auf “ Update Charger” .  Das 
Ladegerät signalisiert mit Pieptönen, wenn die Übertragung abgeschlossen ist.

oder
Um Änderungen zu verwerfen und das vorherige Preset wiederherzustellen: Klicken Sie auf 
„Cancel“ (= Abbrechen)..

 Zur Wiederherstellung der Werkseinstellungen: Klicken Sie auf: “Factory Default“, danach auf 
„Update Charger“ .

Hinwies :  Damit werden die Werkseinstellungen wiederhergestellt. Zusätzlich werden der Kontrast des 
LCD Displays, die Lautstärke  und die „auto scroll settings“ (Definitionen zur Anzeige mehrerer Zeilen auf 
dem LCD Display zurückgesetzt.

Setzen von Optionen für das Ladegerät
1. Klicken Sie auf “Options” .
2. Setzen Sie die Optionen wie folgt:

 Mit “LCD Contrast”  stellen Sie am Ladegerät den Kontrast des LCD Displays ein. Das Display 
ist bei hellem Tageslicht besser abzulesen, wenn ein hoher Kontrast eingestellt wird.

 Wenn die “Auto Scroll Cells ON” Option akiviert ist , so werden während des Ladevorgangs auf 
dem LCD Display nacheinander alle Ladeinformationen angezeigt. Die Option „Auto Scroll  
Seconds” bestimmt, wie lange die jeweiligen Zeilen angezeigt werden, bevor zur nächsten 
Information weitergeschaltet wird.

 Mit “Speaker Volume”  stellen Sie die Lautstärke des Lautsprechers im Ladegerät ein. Wenn das 
Ladegerät jedes Drücken des Mode  bzw. des Start/Stop  Tasters mit einem kurzen Piepton 
bestätigen soll, so klicken Sie auf die „Button Clicks ON“  Option. Zum Stummschalten des 
Lautsprechers im Ladegerät deaktivieren Sie die Option „Speaker ON“ .
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 Die Option “Optimize for Accuracy”  balanciert die Einzelzellen eines Akkus auf 1mV (Millivolt) 
genau.  Das Ladegerät benötigt dafür ca. 2 bis 5 Minutens.  

 “Optimize for Fast Charge”  beendet den Ladevorgang, wenn der Ladestrom bei einem schon 
fast vollständig geladenen Akku auf 0,1C zurückgegangen ist.

3. Klicken Sie auf “Update Charger”, wenn Sie Ihre Definitionen zum Ladegerät übertragen wollen .
oder

Wenn Sie die Änderungen /Definitionen nicht zum Ladegerät übertragen wollen, so klicken Sie auf 
“Cancel“ (= Abbrechen).

Aufzeichnen der Ladedaten
Die “Charge Control” Software kann die Ladedaten für jeden Ladevorgang aufzeichnen. 
1. Drücken Sie den “Start/Stop”  Taster am Ladegerät, um einen Ladevorgang zu starten.
2. Wenn Sie von der Software dazu aufgefordert warden, geben Sie einen Dateinamen ein.  Sie können 

auch einen bereits früher verwendeten Dateinamen angeben, aber Sie müssen dann auch bestätigen, 
dass die älteren Daten überschrieben werden.

Die Ladedaten warden in einem “Semicolon-delimited” Format aufgezeichnert, das für eine genaue 
Analyse in eine Spreadsheet (Arbeitsblatt) importiert werden kann.

Firmware Update
Die “Charge Control” Software überprüft automatisch bei jedem Start, ob eine neuere Version der 
Firmware des Ladegerätes vorhanden ist (dazu muss Ihr PC mit dem Internet verbunden sein).  Wenn 
eine neue Firmware-Version verfügbar ist, wird sie auf Ihren PC übertragen (download). Um diese 
Firmware jetzt auf Ihr Ladegerät zu übertragen, gehen Sie wie folgt vor:
1. Vergewissern Sie sich, dass das Ladegerät mit Ihrem PC verbunden und eingeschaltet ist.
2. Stellen Sie sicher, dass kein Akku am Ladegerät angeschlossen ist.
3. Im “Charge Control Software” Programmfenster klicken Sie  auf  “Firmware“ .
4. Wählen Sie die Firmware aus, die Sie auf das Ladegerät übertragen möchten.
5. Falls der vorherige Firmware Download unterbrochen wurde,so aktivieren die Option „My Charger  

is Dead“ (Ladegerät „tot“ = nicht funktionsfähig).
6. Klicken Sie auf “Update Firmware”.
7. Warten Sie, bis die Übertragung / Update vollständig! abgeschlossen ist.

Wichtig:  Während des Firmware Downloads trennen Sie das Ladegerät nicht von der Stromquelle, 
unterbrechen nicht die Verbindung zwischen PC und Ladegerät und verlassen / beenden (exit) Sie auch 
nicht  die „Charge Control“ Software.
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Schaltplan Balancer Anschluss

Dieses Diagramm erläutert, wie ein 6 Pin  Balancerstecker an ein 5S LiPo Akku (Akku mit 5 in Serie 
geschalteten Einzelzellen) angeschlossen ist.

Bestimmung der Akku-Leistungsfähigkeit

Wenn Sie die elektrischen Werte Ihres Antriebssystems nicht direkt messen können, ao können Sie diese 
mit dem Cellpro 10s Ladegerät näherungsweise durch Messungen vor und nach einem Flug bestimmen.

Berechnungsdaten ermitteln
Laden Sie den Akku.


Wenn der Akku geladen ist, notieren Sie sich die Werte “Fuel %“  (Ladezustand in %) und „total pack  
voltage“, die Gesamtspannung des Akkus (=Summe aller Einzelzellenspannungen).


Fliegen Sie das Modell oder aber testen Sie es am Boden.  Notieren Sie die Flugzeit  (oder Laufzeit am 
Boden) in Minuten .


Schließen Sie danach den Akku an das Ladegerät an. Notieren Sie jetzt erneut die Werte für “Fuel %“  
(Ladezustand in %) und „total pack voltage“.
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Berechnen der Leistungswerte

Bewertung der Ergebnisse
 Durchschnittlicher Stromverbrauch  während des Fluges gibt Ihnen einen ungefähren Überblick, ob 

alle Systemkomponenten – Regler, Motor, Steckverbindungen und Verkabelung – ausreichend 
dimensioniert sind und nicht überlastet warden. Denken Sie jedoch daran, dass der während des 
Fluges augenommene Spitzenstrom den von Ihnen errechneten Wert ganz eheblich übersteigen kann. 

 Watt pro Kilo Fluggewicht ist ein ungefährer Indikator für die Leistungsfähigkeit Ihres Flugmodells 
(weitere Faktoren, welche die Leistungsfähigkeit des Flugmodells beinflussen sind: Auftrieb, 
Luftwiderstand und Motortyp). Hier einige Richtlinien:
 55 to bis 66 Watt pro Kilo: Horizontalflug.
 88 to 120 Watt pro Kilo: Start von glatter Oberfläche (z.B. Asphalt), Steigflug.
 110 to 165 Watt pro Kilo: Start von Graspiste, einfacher Kunstflug.
 165 to 275 Watt pro Kilo: Kunstflug.
 Über 275 Watt pro Kilo: 3D.

Hinweis :  Für weitere direkte elektrische Messung könnten die folgenden FMA Produkte hilfreichsein:
 60A Current Shunt (Model DVM-SHUNT-60) – für Strommessungen
 Digital Multimeter (Model DVM-VC890D) – Spannungs- und Widerstandsmessungen
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Fehlersuche

Es gibt bis zu 26 Möglichkeiten, zwei Akkus an das Ladegerät anzuschließen!  Nach dem Drücken des 
“Start/Stop”  Tasters wird durch das Ladegerät  überprüft das Ladegerät mit einer speziellen 
Testsequenz jede Anschlussleitung, bevor die internen Schalter den Ladevorgang aktivieren (Falls nur 
die Balancer-Anschlüsse zum Laden benutzt werden und die normale Akkukabel nicht am Ladegerät 
angeschlossen sind).  Es ist daher möglich, dass Sie selbst bei einem einfachen Verkabelungsproblem 
eine Fehlernachricht erhalten, die nichts mit dem eigentlichen Problem zu tun hat.

Bedienungsfehler werden durch eine Nachricht im LCD Display des Ladegerätes angezeigt. Die 
nachfolgenden Nachrichten beschreiben das Problem und geben Hinweise zur Behebung. Korrigieren Sie 
dann den Fehler. Wenn der Fehler weiterhin auftritt, kontaktieren Sie bitte den FMA Kundendienst 
(customer service).

Nachricht ( Message) Problem
2 Pack Con. Err Akkuverkabelung überprüfen
Amps too low Ladegerät zurücksetzten (Reset)
Bad EEPROM Write Interner Fehler
Bad FET supply voltage Überprüfen Sie die Eingangsspannung
Bad Mode Number Interner Fehler
Bypass Overvolt Akkuverkabelung überprüfen 
C2 Pack Detected Akku wurde während eines Ladevorgangs an CH2 angeschlossen
Cell < 0.1V Zellenspannung niedrig
Ch1 Bad S. Count Die Zellenzahl kann nicht ermittelt werden, prüfen ob eine Einzelzelle < 0.5V
Ch1 has no Pack Akku muss an CH1 angeschlossen werden
Ch1 No Add Up Fehler bei Zellenüberprüfung an CH1
Ch1 Pos < 0.5V Verdrahtung des balancerkabels überprüfen
Ch2 Bad S. Count Zellenzahl kann nicht bestimmt warden, prüfen, ob eine Einzelzelle  < 0.5V
Ch2 No Add Up Fehler bei Zellenüberprüfung an CH2
Charger Overcurrent Überprüfen, ob Ladestrom konstant ist
Check Pos. Term Pluspol nicht angeschlossen
Chg. Overvoltage Zelle hat Überspannung
Chgr Temp. >160F Ladegerät wird zu heiss, Ventilator auf Funktion überprüfen
Low Voltage Cell Nach 5 Minuten Ladezeit ist Zellenspannung immer noch zu niedrig
Neg. Term. < 0V Spannung  < 0V (negative Spannung) am schwarzen Anschlussstecker 
No Plug Blocker Plug Blocker erforderlich, aber nicht installiert
Node 10 < 0V Der letzte Anschluss des Balancerkabels zeigt negative Spannung an
Reverse Polarity Akkuverkabelung überprüfen 
Series Chrgrs? Stellen Sie sicher, dass nicht zwei Ladegeräte gleichzeitig in Serie 

geschaltete Akkus laden
Supply <10 Volts Versorgungsspannung des Ladegerätes unter 10 Volt
Supply >16 Volts Versorgungsspannung des Ladegerätes über 16 Volt
Supply Unstable Entweder zu dünne Anschlussleitungen zwischen Netzteil und Ladegerät 

oder zu schwaches Netzteil. Begrenzen Sie den Eingangsstorm mit der 
„Charge Control“ Software

System Softstart Überprüfen Sie die Anschlussleitungen zwischen Netzteil / Batterie und dem 
Ladegerät

Temp out of Rnge Vergewissern Sie sich, dass der Ventilator einwandfrei funktioniert
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Falsch verkabelte Akkus können irreführende Fehlermeldungen hervorrufen.  Wenn einer der nach-
folgenden „Safety codes” ( = Sicherheitscodes) angezeigt wird, so schließen Sie den Akku  über seine 
Anschlusskabel  und den Balanceranschluss ohne Verwendung des „Plug blocker“ an das Ladegerät an..

Safety code Problem
60-65 Fehler “Positive switch close”
66-71 Fehler “Series switch close”
72-77 Fehler “Negative switch close”
78 Mehr als 42V erkannt
79-80 Zellenzahl zu hoch  (Interner Software Check)
81-86 Fehler “Charge switch close”
87 Spannung über längere Zeit instabil “Voltage steady timeout”
88 Check Pack 1 voltage out of range
89 Check Pack 2 voltage out of range
90-92 Interner Software Check
93 Calibration checksum Error.  Das Ladegerät muss zur Kalibrierung zum Hersteller geschickt werden.

Technische Daten
Batterietypen Lithium Polymer, Lithium Ion, Lithium Manganese und A123 Akkus; Ladegerät 

unterstützt 1s bis 10s Akkus mit Balanceranschluss, die mit einem geeigneten FMA 
Adapterkabel an das Ladegerät angeschlossen sind.

Akkukapazität 100mAh bis 65Ah (Ladezeit ist auf maximal 12 Stunden begrenzt))
Eingangsspannung 10 bis 16VDC mit Verpolungsschutz
Eingangsstrom Bis zu 25A; kann auf 1A bis 25A in 0.25A Schritten begrenzt werden
Spannungswandler 62.5kHz Spannungswandler, 90% Wirkungsgrad
Nominale Ausgangsspg 3.60, 4.10 und 4.20 Volt proZelle, 42V Maximal
Ausgangsstrom Bis zu 3A mit Verpolungsschutz
Zellenbalancer 1mV mit einer Auflösung von 0.1mV
Spannungskalibrierung Messung der Zellenspannung werkskalibriert auf 1ppm (50µV) traceable to NIST
Interne Schalter Vier internal FET Schalter (Switches), schalten Akkus in Serie, um über die 

Balancerkabel laden zu können. Die Schalter schließen erst nach  Über- prüfung des 
korrekten Akkuanschlusses. Der Maximalstrom pro Switch ist auf 4A begrenzt.

Plug blocker Verhindert den verpolten Anschluss des Akkus an die Buchsen des Lade-geräts, 
nachdem die internen Schalter geschlossen sind. Das Ladegerät überprüft 
dasVorhandensein eines 4.7 K Widerstands (befindet sich auf dem Block Blocker) bei 
Aktivierung der internen Schalter

Stromkalibrierung Der Ladestrom ist an einer 4A Konstantstromquelle ab Werk kalibriert, Genauigkeit: 
±5mA

Messgenauigkeit Gesamtspannung:  ±2mV im Bereich von 0 bis 50V
Ladestrom:  ±1%
In den Akku geladene Kapazität:  ±1%
Kapazität in % (“Fuel”):  ±5%

Innenwiderstand Auflösung von 0.1mV ermöglicht eine genaue “Vierpunkt” Widerstandsmessung für 
jede Einzelzelle

Serielle Schnittstelle 19.2kbps, 8 Bits, 1 Start Bit, 1 Stop Bit, keine Parity; CRC16 Prüfsumme
Firmware Updates Im Werk verschlüsselt, im Ladegerät wieder entschlüsselt

© Ringel Modellbau 2008 
Alle Rechte beim Verfasser

25



FMA limited warranty

FMA, Inc. warrants this product to be free of manufacturing defects for the term of one year from the date 
of purchase.  Should any defects covered by this warranty occur, the product shall be repaired or 
replaced with a unit of equal performance by FMA or an authorized FMA service station.
Limits and exclusions
This warranty may be enforced only by the original purchaser, who uses this product in its original 
condition as purchased, in strict accordance with the product’s instructions.  Units returned for warranty 
service to an FMA service center will be accepted for service when shipped postpaid, with a copy of the 
original sales receipt or warranty registration form, to the service station designated by FMA.
This warranty does not apply to:
 Consequential or incidental losses resulting from the use of this product.
 Damage resulting from accident, misuse, abuse, neglect, electrical surges, reversed polarity on 

connectors, lightning or other acts of God.
 Damage from failure to follow instructions supplied with the product.
 Damage occurring during shipment of the product either to the customer or from the customer for 

service (claims must be presented to the carrier).
 Damage resulting from repair, adjustment, or any alteration of the product by anyone other than an 

authorized FMA technician.
 Installation or removal charges, or damage caused by improper installation or removal.

Call (301) 668-7614 for more information about service and warranty repairs.
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